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About this document

Version

3.10

Scope and purpose

The Smart 1/0 Configurator is part of a collection of tools included with the ModusToolbox™ software. It
provides a GUI to configure the Smart 1/0.

Intended audience

This document helps application developers understand how to use the Smart I/O Configurator as part of
creating a ModusToolbox™ application.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus
Italics Denotes file names and paths.

Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,

Courier New X R A X
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions

The following define the abbreviations and terms used in this document:
e HSIOM - high-speed I/0 matrix

e PDL - peripheral driver library

e UDB - universal digital block

Reference documents

Refer to the following documents for more information as needed:

e Eclipse IDE for ModusToolbox™ user guide

e Device Configurator guide

e ModusToolbox™ user guide

e PDL API reference guide
e Device datasheets

e Device technical reference manuals
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Overview

1 Overview

The Smart 1/0 block adds programmable logic to an I/O port. It is positioned in the signal path between the
high-speed 1/0 matrix (HSIOM) and the I/O port. The HSIOM multiplexes the output signals from fixed-function
peripherals and the CPU to a specific port pin and vice-versa. The Smart 1/0 block is placed on this signal path,
acting as a bridge that can process signals between port pins and the HSIOM, as shown in the following
diagram. For more information about the Smart 1/0 block, refer to the device Technical Reference Manual.

SMART /O
Data Unit

HSIOM 76 port
Rout i Is { o) » i o > » -
frgmu gﬁiSI?gT}g Chip connections Routing 1/0 connections Pins in a

P SMART 1/O port
pins
LUT

There are several areas in the GUI to configure signals: Chip, I/O, Data Unit, and LUT. Inputs to the chip from the
I/O port can be logically operated upon before being routed to the peripheral blocks and connectivity of the
chip. Likewise, outputs from the peripheral blocks and internal connectivity of the chip can be logically
operated upon before being routed to the I/0 port.

The programmable logic fabric of the Smart 1/0 can be purely combinatorial or registered with a choice of clock
selection. The functionality is completely user-defined, and each path can be selectively bypassed if certain
routes are not required by the fabric.

Each Smart I/0 is associated with a particular /0O port and consumes the port entirely. If the Smart /O is not
enabled, then the Smart I/O functionality for that port is bypassed.

Note: Bypassed means each chip terminal is routed directly to the corresponding I/0 terminal.
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2 Launch the Smart I/O Configurator

There are numerous ways to launch the Smart I/O Configurator, and those ways depend on how you use the
various tools in ModusToolbox™ software.

2.1 make command

As described in the ModusToolbox™ user guide build system chapter, you can run numerous make commands
in the application directory, such as launching the Smart I/O Configurator. After you have created a
ModusToolbox™ application, navigate to the application directory and type the following command in the
appropriate bash terminal window:

make open CY OPEN TYPE=smartio-configurator

This command opens the Smart I/0 Configurator GUI for the specific application in which you are working,.

2.2 Eclipse IDE

If you use the Eclipse IDE for ModusToolbox™, you can launch the Smart 1/0 Configurator for the selected
application. In the Project Explorer, right-click on the project and select ModusToolbox™ > Smart 1/O
Configurator <version>. You can also click the Smart 1/0 Configurator link in the IDE Quick Panel.

Eyp 2 4D MR Zp = 8 & Quic.. (9=Vari.. #TExp.. % Bre. = O
2% Y §
=5 Hello_World .
e , Eclipse IDE for
™
Golnto ModusToolbox
Open in New Window » Start
Shoull S D) b Hello_World (CYSCKIT-062-WIFI-BT)
s ModusToolbox™ > Library Manager 1.40 Ctrl+8
» Launches
Show in Local Terminal b Bluetooth Configurator 2,50 (new configuration) .
2 Copy Ctrl+C CapSense Configurator 4.0 Lol
Paste Ctrl+V CapSense Tuner 4.0 Q Library Manager 1.40
% Delete T Device Configurator 3.10 [ Blustooth Configurator 2.50 (new configuration)
Source N Device Firmware Update Host Tool 1.50 & CepSense Configurator 4.0
Move... ML Configurater 1.20 & Capsense Tuner 40
Rename... F2 S Can e En [ Device Configurator 2.10
— Smart /0 Configurator 310 [ Device Firmuare Updste Host Taol 150
B mport-. USB Configurator 2.40 (new configuration) G ML Configurator 120
= v onfigurator 1.2U
& 0sPI Configurator 3.0
[ Smart /0 Configurator 3.10
[ USE Configurator 2.40 (new configuration)

Similar to the make command method, launching the Smart 1/0 Configurator using the Eclipse IDE opens the
tool for the selected application. Refer to the Eclipse IDE for ModusToolbox™ user guide for details about the
IDE.

2.3 From the Device Configurator
To launch the Smart 1/0 Configurator GUI from the Device Configurator:

1. Open the Device Configurator. See the Device Configurator guide for details.

2. Onthe Pins tab, expand Port 8 and/or Port 9, and enable the Smart 1/0 resource.

3. Onthe Parameters tab, click the Launch Smart 1/0 Configurator button.
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2.4 Executable (GUI)

If you don't have an application or if you just want to see what the configurator looks like, you can launch the
Smart 1/0 Configurator GUI by running its executable as appropriate for your operating system (for example,
double-click it or select it using the Windows Start menu). By default, it is installed here:

<install_dir>/ModusToolbox/tools_<version>/smartio-configurator-<version>

When launched this way, the Smart I/O Configurator opens without any settings configured. You can either
open a specific configuration file or create a new one. See Menus for more information.

Note: The Smart I/0 uses the *.modus file that is also used by the Device Configurator for the same
application.

User Guide 50f21 002-24729 Rev. *H
2021-09-24



o _.
ModusToolbox™ In f| neon
Smart 1/0 Configurator guide

Quick start

3 Quick start

The Smart 1/0 is a port-wide resource that has a close relationship with the port to which it is dedicated. Hence
the connectivity of peripherals to the Smart /0 will differ based on which device and which portis used. To use
the Smart 1/0:

1. Launch the Smart /O Configurator.

2. Usethe various pull-down menus to configure signals. Refer to the descriptions in the Routing tab section
for more details.

3. Savethe file to generate source code.

The Smart 1/0 Configurator generates code into a "GeneratedSource" directory in your Eclipse IDE
application, or in the same location you saved the *.modus file for non-IDE applications. That directory
contains the necessary source (.c) and header (.h) files for the generated firmware, which uses the relevant
driver APIs to configure the hardware.

4. Use the generated structures as input parameters for Smart 1/0 functions in your application.

For more information, refer to the Peripheral Driver Library (PDL) API Reference documentation.
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GUI Description

4 GUI Description

The Smart 1/0 Configurator GUI contains menus and tabs to configure 1/0 settings.
4.1 Menus

4.1.1 File

e New - Creates a new *.modus file.

e Open - Opens and loads an existing *.modus file.

e Close - Closes the current file (leaves the application open).

e Save - Saves changes to the file. If the file does not exist, the Save file dialog opens.
e Save As... - Saves changes to a new file.

e Openin System Explorer - This opens your computer’s file explorer tool to the folder that contains the
design.modus file.

e Change Library - Opens a dialog to select a different library (devicesupport.xml) file used for resource
Personalities. See the Device Configurator guide for more details.

o Recent Files - Lists up to five recently opened *.modus files, which you can select to re-open.

e Exit - Closes the configurator.

4.1.2 View

¢ Notice List - Shows/hides the Notice List pane, which contains any errors, warnings, tasks, and
information notes. See the Device Configurator guide for more details.

e Toolbar - Shows/hides the Toolbar.

4.1.3 Help

o View Help - Opens this document.

e About - Opens the About box for version information.
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4.2 Tabs

4.2.1 Routing tab

The Routing tab is used to define the general settings and the routing configuration of the Smart 1/0.

FEile View Help
Routing Data Unit LuT4

Port: |Port8 (Smart I/ 8) ~ | Clock: |Asynchronous v %ShowRoutmg Matrix XC\Ear

Chip 7 Bypass ~

1/07 Bypass v

Chip6 Bypass ~ | 1/0 6 Bypass i

Chip5 Bypass ~

!

|

|

ﬁ

|

F

|

+* 105 Bypass v

Qutput ~

Chip3 Bypass v

1/03 Bypass ~

Chip2 Bypass v
1/02 Bypass ~

Chip1 Bypass v
101 Bypass ~

Chip0 Bypass ~
/00 Bypass ~

01 2 01 2
wre & || wr7 &

01 2 01 2 01 2 01 2
wre & ||wr @ (w2 & || wr3 &
None ||| MNome + || Nome + || Nome ~ None ~ || MNone ~

Mone None  ~ None  ~ None  ~ None — ~ None — ~

This tab contains the following parameters:

4.2.1.1 Port

Valid peripheral connections of a Smart /O are port- and device-specific. This parameter allows selecting a port
that supports Smart 1/0.

4.2.1.2 Clock

Selects the clock source used to drive all sequential logic in the block. This clock is global within the Smart 1/0
and has differing constraints suited to different applications. Refer to the Functional Description section for
more information.

e Signalon /O terminal 7...0 - Uses the selected I/O signal as the clock source. This signal may not be used
in LUT inputs if used as the clock source.

¢ Signal on Chip terminal 7...0 - Uses the selected Chip (peripheral or UDB) signal as the clock source. This
signal may not be used in LUT inputs if used as the clock source. This clock can only be used during chip
active and sleep modes.

o Peripheral clock divider (Active) - Divided clock from HFCLK. This clock is operational only in chip Active
and Sleep modes. Sequential elements will be reset when entering Deep-Sleep or Hibernate mode and at
POR.
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e Peripheral clock divider (Deep-Sleep) - Divided clock from HFCLK. This clock is operational only in chip
Deep Sleep modes. Sequential elements will be reset when entering Hibernate mode and at POR.

o Peripheral clock divider (Hibernate) - Divided clock from HFCLK. This clock is operational only in chip
Hibernate modes. Sequential elements will be reset only at POR.

e Clk_LF - Low Frequency clock (either from ILO or WCO). This clock operates during chip Active, Sleep and
Deep-sleep and allows the Smart I/O sequential logic to be clocked during those power modes.

e Asynchronous - If the Smart |/O is used purely for combinatorial logic, this option allows the block to
conserve power by not using a clock. There are no constraints to power modes with this selection.

4.2.1.3 Show Routing Matrix

This button hides or displays the Smart I/0 routing matrix. If the routing matrix is shown, you may click on the
switches in the fabric to make input connections to the LUTs.

4.2.1.4 Clear

Click on this button to reset the routing matrix. All DU and LUT inputs will be cleared and the Chip and I/0
terminal directions will become bypassed.

4,2.1.5 Chip configuration

There are eight Chip signals that can be configured. Each has two pull-down menus; one to select the direction
of the signal and the other to select the connection.

Input{Async) -

TCPWMI0] 32-bit Counter 7 prm_n [USED] - 1

Chip 7...0 direction
Defines the direction of the specified Chip terminal. Valid options include:

e Bypass - The line is bypassed and do not go through the Smart I/O routing fabric. i.e. Connection between
the chip resource and the pin are directly connected. Bypass option frees this line and allows
ModusToolbox™ to use this pin location for placing resources not meant to be used in the Smart /0 fabric.

¢ Input (Sync/Async) - Changes the direction of the terminal to be input type and allows connecting the
matching peripheral/UDB signal to it. Input signals can be used as inputs to the LUTs. These can be either
synchronized to the clock or remain asynchronous.

e Output - Changes the direction of the terminal to be output type and allows connecting the matching
peripheral/UDB signal to it. Output signals can only be driven by the corresponding LUT outputs.

e None - The Chip terminal is consumed and cannot be used for connecting chip resources to it. This option
is chosen automatically if the corresponding I/0 terminal on the channel is specified as either Input or
Output. You may use the terminal if the direction is set to Output or Input (only allowed if corresponding
I/Ois Output).

Chip 7...0 connection

When a Port is specified, these parameters allow each of the Chip terminals to connect to another peripheral
on the chip.
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4.2.1.6 1/O configuration

There are eight 1/0 signals that can be configured. Each has a pull-down menu to select the direction of the
signal.

— Oubpuk -

A

1/0 7...0 direction
Defines the direction of the specified 1/0 terminal. Valid options are:

e Bypass - The line is bypassed and do not go through the Smart I/O fabric. i.e. Connection between the chip
resource and the pin are directly connected. Bypass option frees this line and allows ModusToolbox™ to
use this pin location for placing resources not meant to be used in the Smart 1/0 fabric.

¢ Input (Sync/Async) - Changes the direction of the terminal to be input type and allows connecting an
input 1/0 pin to it. Input signals can be used as inputs to the LUTs. These can be either synchronized to the
clock (Sync) or remain asynchronous (Async).

e Output - Changes the direction of the terminal to be output type and allows connecting an output I/O pin
to it. Output signals can only be driven by the corresponding LUT outputs.

e None-Thel/O terminalis consumed and cannot be used for connecting a pin to it. This option is chosen
automatically if the corresponding Chip terminal on the channel is specified as either Input or Output. You
may use the terminal if the I/O direction is set to Output or Input (only allowed if corresponding Chip is
Output).

4.2.1.7 Data Unit input configuration

The Data Unit configuration section contains three pull-down menus to select inputs. As you make various
selections, the Data Unit tab becomes available for selection. You can also click the link icon to access the tab.

DU TRO, TR1, TR2

Defines the inputs for Data Unit triggers TR0, TR1 and TR2. The purpose of the triggers are dependent on the
chosen Opcode as specified in the Data Unit tab. The triggers are active high.

e Constant 0 - Default input selection. This effectively makes the trigger input to not perform any operation
on the DU.

e Constant 1 - Ties the trigger high, which activates and maintains the chosen DU operation.
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e DU - Feeds back the single 1-bit DU output.
e LUTO...7 - Accepts any of the LUT outputs as an input.

4.2.1.8 LUT input configuration

There are eight LUT signals that can be configured. Each LUT configuration section contains three pull-down
menus to select inputs from Chip, I/0, and DUT resources. As you make various selections, the corresponding
LUT tab becomes available for selection. You can also click the link icon to access the tab.

LUT 7...0, Input 0

Defines the input 0 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design. The LUT input 0 may accept any LUT outputs as an input with the exception of LUT
0. Instead, it may accept the DU output as an input.

e DU -The 1-bit output from the DU.

o LUT1...7-Accepts the outputs of LUT1 to LUT 7.

e |Ifusing LUT0...3,1/0/Chip 0...3 signals are allowed as potential inputs.
e |Ifusing LUT 4...7,1/0/Chip 4...7 signals are allowed as potential inputs.

LUT7...0, Input 1

Defines the input 1 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design.

e LUTO...7 - Accepts the outputs of LUTO to LUT 7.
e |Ifusing LUT0...3,1/0/Chip 0...3 signals are allowed as potential inputs.
e |Ifusing LUT 4...7,1/0/Chip 4...7 signals are allowed as potential inputs.

LUT7...0, Input 2

Defines the input 2 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design.

e LUTO...7 - Accepts the outputs of LUTO to LUT 7.

e Ifusing LUT0...3,1/0/Chip 0...3 signals are allowed as potential inputs.

e |Ifusing LUT 4...7,1/0/Chip 4...7 signals are allowed as potential inputs.
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4.2.2 Data Unit tab

When the DU in the Routing tab is configured to accept an input other than a Constant 0, the corresponding
Data Unit configuration tab will appear.

File View Help
Routing Data Unit  LUT4

Opcode: Increment
DATAD: Constant 0

DATAL: Constant 0

< < < <

Size: &-bits sizefwidth operand
Details: Clock = Asynchrenous
TRO = LUT4
TR1=LUT4

Increment
du_size = Size - 1
mask = (1 << (du_size + 1)) - 1

data_eql_data = (data & mask) == (DATAT & mask) TRO — rst out — TR_out
Combinatorial:
tr_out = data_eql_datal
Registered/Clocked: TR1— en
data <= data
if (TR)
{
data <= DATAD & mask Clock > clk
}
else if (TR1)

{
data <= data_eql_datal 7 data: (data +1) & mask
i

Ready

This tab contains the following parameters:

4,2.2.1 Opcode

Defines the Data Unit operation. Each opcode performs a unique function that can be controlled using the DU
trigger inputs TRO, TR1 and TR2.

Note: Not all trigger inputs are required for a chosen Opcode. Refer to the pseudo verilog code in the
Details window and also to the Functional Description section for more information.

e Increment - Implements an 8-bit One-shot Up Counter. The DU output goes high when the internal DU
working data register is equal to DU DATA1 value.

e TRO=reset signal that resets the working register to DU DATAO value
e TR1=-enablesignal to start the increment operation

e Decrement - Implements an 8-bit One-shot Down Counter. The DU output goes high when the internal DU
working data register is equal to 0.

e TRO=reset signal that resets the working register to DU DATAO value
e TR1=enable signal to start the decrement operation

e Increment and wrap - Implements an 8-bit Up Counter that wraps when it reaches DU DATA1 value. The
DU outputis a single clock pulse when the internal DU working data register is equal to DU DATAL value.

o TRO=resetsignal that resets the working register to DU DATAO value
e TR1=enablesignal to start the increment operation

e Decrement and wrap - Implements an 8-bit Down Counter that wraps when it reaches 0. The DU output is
asingle clock pulse when the internal DU working data register is equal to 0.

e TRO=reset signal that resets the working register to DU DATAO value

e TR1=enablesignal to start the decrement operation
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¢ Increment/Decrement - Implements an 8-bit Up/Down Counter. The DU output goes high when the
internal DU working data register is equal to either DU DATA1 register or if it is equal to 0.

e TRO=reset signal that resets the working register to DU DATAO value
e TR1=enablesignal to start the increment operation
e TR2=enable signal to start the decrement operation

¢ Increment/Decrement and wrap - Implements an 8-bit Up/Down Counter that wraps when it reaches
either DU DATAL (count up) or when it reaches 0 (count down). The DU output goes high when the internal
DU working data register is equal to either DU DATAL register or if it is equal to 0.

e TRO=resetsignal that resets the working register to DU DATAO value
e TR1=-enable signal to start the increment operation
e TR2=enablesignal to start the decrement operation

e Rotate Right - Implements a right circular shift register. The DU output is the LSB of the working register,
which also gets fed back to the MSB of the working register.

e TRO = load signal that loads the working register with DU DATAO value
e TR1=enablesignal to start the shift right and rotate operation
¢ Shift Right - Implements a right shift register. The DU output is the LSB of the working register.
e TRO = load signal that loads the working register with DU DATAO value
e TR1=enablesignal to start the shift right operation
e TR2=shiftin value that gets inserted into the MSB of the working register

e AND, OR - Implements a bitwise AND operation on the DU working register and DU DATAL. The DU output s
high if the result of the operation is true.

e TRO =load signal that loads the working register with DU DATAO value

¢ Shift right and Majority 3 - Implements a shift register with a majority 3 comparison. The DU output will
go high if the contents of the working register is equal to 0x03, 0x05, 0x06 or 0x007.

e TRO = load signal that loads the working register with DU DATAO value
e TR1=enablesignal to start the shift right operation
e TR2=shiftin value that gets inserted into the MSB of the working register

o Shift right and Compare - Implements a shift register with a match DU DATAL1 value comparison. The DU
output will go high if the contents of the working register is equal to DU DATAL.

e TRO =load signal that loads the working register with DU DATAO value
e TR1=enablesignal to start the shift right operation
e TR2=shiftin value that gets inserted into the MSB of the working register

4.2.2.2 DATAO

Defines the DU DATAO register source. This value is often used as the initial/reset value that is loaded into the
DU working register when TRO signal is high.
e Constant 0 - Source is constant 0x00

e Chipsignal [7:0] - Sourced from all 8 Chip terminals of the Smart I/O, allowing internal chip signals to be
directly loaded into DATAO

e 1/0 Signal [7:0] - Sourced from all 8 /O terminals of the Smart I/0, allowing external signals to be directly
loaded into DATAQ
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o DATA Register - Sourced from the DU Register, which is accessible by the CPU

4.2.2.3 DATA1l

Defines the DU DATAL1 register source. This value is often used as the comparison value that gets applied to the
DU working register.

Note: DU DATAL is not necessary for all Opcodes.

e Constant 0 - Source is constant 0x00

e Chip signal [7:0] - Sourced from all 8 Chip terminals of the Smart I/0, allowing internal chip signals to be
directly loaded into DATA1

e /0 Signal[7:0] - Sourced from all 8 1/0O terminals of the Smart /0, allowing external signals to be directly
loaded into DATA1

e DATA Register - Sourced from the DU Register, which is accessible by the CPU

4.2.2.4 Register Value

Defines the 8-bit DU Reg value. This value is used as a source for DATAO and/or DATAL.

Note: DU Reg is available only if either DATAO or DATAI are configured to be sourced from it.

4.2.2.5 Size

Defines the bit size operation to be performed by the data unit. Valid range is from 1 to 8 bits.

4.2.3 LUT tabs

When a LUT in the Routing tab is configured to accept an input, the corresponding LUT configuration tab will
appear.

File VNiew Help
Routing Data Unit LuT4
Mode: Combinatorial output Mapping:
TR 2: (Chip 5) TR 1: (Chip 7) TRO: (/0 4) Set Bit
] 0 ] 0
TRO
Looku 0 0 1 0
TR Tablo > Out
TR2 —» o 1 0 0
0 1 1 0
1 0 0 0
1 0 1 0
1 1 ] 0
1 1 1 0
Ready
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This tab contains the following parameters:

4.2.3.1 LUT 7...0 mode

The LUTs can be configured in one of four modes:
e Combinatorial - The LUT is purely combinatorial. The LUT output is the result of the LUT mapping truth
table, and will only be delayed by the LUT combinatorial path.

o TR2 gated, combinatorial output - The LUT input 2 is registered. The other inputs are direct connects to
the LUT. The LUT output is combinatorial. You may use the output to feed back into input 2.

e Sequential (gated) output - The inputs are direct connects to the LUT but the output is registered.

e Asynchronous Set/Reset mode - The inputs and the LUT truth table are used to control an asynchronous
S/R flip-flop.

4.2.3.2 LUT 7...0 output mapping

Defines the lookup truth table of the 3-to-1 LUT. The state on the three inputs (input 0, 1 and 2) are translated
to an output value according to this truth table.

Note: If the LUT is used to operate on a single signal (e.g. to invert a signal), then that signal must be
connected to all 3 inputs of the LUT.
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5 Functional Description

The Smart 1/0 implements a port-wide logic array that can be used to perform routing and logic operations to
peripheral and I/0 signals. The following sub sections describe the block restrictions and application critical
information.

5.1 Routing Fabric

The Smart 1/0 routing fabric is divided into two portions, where each portion is capable of accepting half of the
Chip or 1/O signals. The LUTs have the following structure.

e LUTT7...4arecapable of accepting signals from 1/0 / Chip 7...4 as inputs.

e LUT 3...0 are capable of accepting signals from 1/0 / Chip 3...0 as inputs.

e TheLUTs canaccept any LUT output as an input.

e Each LUT output is dedicated to the corresponding output I/0 and Chip terminals. For example, LUT 0 can
go to either 1/0 0 terminal (output type) or Chip 0 terminal (output type). The LUT output cannot be routed
to an input terminal type.

5.1.1 Single Source LUT Input

If a LUT is used, all three inputs to the LUT must be designated. For example, even If a LUT is used to accept a
single source as its input, all three inputs must accept that same signal. The lookup truth table should then be
designed such that it only changes the output value when all three inputs satisfy the same condition.

For example, consider the case where the signal on Chip 5 must be inverted before being passed to 1/0 5. LUT 5
accepts Chip 5 asinput 0,1 and 2. The truth table is defined such that it outputs a logic 1 only when the inputs
areall 0.

TR 2: (Chip5) TR 1; [Chip 5) TRO: (Chip 5 Set Bit

0 ]
TRO
TR1
TR2 -

Lookup
Table > Out

0
0
0
1
1
1
1

=M-BcB=0=-0=0=

Output: Hex - 01

5.1.2 SCB Restriction

The SCB routing paths are restricted and can only be connected to the dedicated pin. They can however go
through the dedicated LUT. For example, an SCB SPI slave select line on Chip 2 may be an input to LUT2, and
then the output go to I/0 2. It cannot go to any other LUTs.
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5.2 Clock and Reset behavior

The Smart 1/0 Configurator drives its synchronous elements using a single peripheral-wide clock. Depending on
the clock source, the Configurator will have different reset behaviors, which will reset all the flip-flops in the
LUTs and synchronizers to logic 0. The configuration registers will retain their values unless coming out of
Power on Reset (POR).

Note: If the Configurator is only disabled, the values in the LUT flip-flips and 1/0 synchronizers are held as
long as the chip remains in a valid power mode.

Note: The selected clock for the fabric’s synchronous logic is not phase aligned with other synchronous
logic on the chip operating on the same clock. Therefore, communication between the Smart /0
and other synchronous logic should be treated as asynchronous (just as the communication
between I/0 input signals and other synchronous logic should be treated as asynchronous).

Clock source Reset behavior Enable delay Description

If chosen as the clock source, that particular signal
cannot also be used as an input to a LUT as it may

/07...0 Reset on POR 2 clock edges cause a race condition. The fabric will be enabled
after 2 clock edges of the signal on the I/O terminal.
If chosen as the clock source, that particular signal

Chip7...0 Reset on POR 2 clock edges cannot also be used as an input to a LUT as it may

cause a race condition. The fabric will be enabled
after 2 clock edges of the signal on the Chip terminal.

The fabric will be enabled after 2 clock edges of the

Reset when going to divided clock. Any synchronous logic in the LUTs will

Peripheral Clock Deep Sleep, 2 clock edges

Divider (Active) Hibernate or POR be reset to 0 when in chip deep-sleep or hibernate
modes.
Peripheral Clock Reset when going to The fabric will be enabled after 2 clock edges of the

2 clock edges divided clock. Any synchronous logic in the LUTs will

Divider (Deep-Sleep) | Hibernate or POR be reset to 0 when in hibernate mode.

Peripheral Clock The fabric will be enabled after 2 clock edges of the

Reset on POR 2 clock edges

Divider (Hibernate) divided clock.
Reset when oine to The fabric will be enabled after 2 clock edges of the
Clk_LF Hibernate ar%d PgR 2 clock edges low frequency clock (LFCLK). Any synchronous logic
! in the LUTs will be reset to 0 when in hibernate mode.
3 clock edges The fabric will be enabled after 3 clock edges of the
Asynchronous Reset on POR of SYSCLK system clock (SYSCLK).
5.2.1 Signal synchronization requirement

If any of the signals coming in through the Smart I/O are meant to be used in sequential elements in the LUTSs,
the terminal synchronizer must first be used to synchronize that signal to the peripheral clock. For example, if
the signal on 1/0 0 must be used in LUTO in Sequential output mode, the synchronization for 1/0 0 terminal
should be enabled for reliable operation.
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5.3 LUT combinatorial feedback

Since the LUTs can be configured as purely (or partially) combinatorial elements and since they can chain to
each other in any fashion, combinatorial timing loops can occur. This causes oscillations that burn power and
create unpredictable behavior. If a feedback is required, the signals should always go through a flip-flop before
feeding back. For example, the following is a potentially problematic design. LUT1 and LUT2 are configured in
Combinatorial mode. This will result in oscillations. To prevent it, one of the LUTs should be configured to
Gated Output mode.

Lo b

0 In1  In2 0 Inl In2
LUT1 LUT2
out out
]
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6 Version changes

This section lists and describes the changes for each version of this tool.

Version Change descriptions
1.0 New tool.
1.1 Updated to incorporate changes to the back end.
1o Implemented various defect fixes and performance enhancements.
Added Open Containing Folder menu item.
Updated to incorporate changes to the back end; version updated to be in sync with Device
Configurator.
2.1 Added Open System Explorer menu item.
Added Change Devices menu item and dialog.
Added major/minor version number to the title bar.
520 Added Copy feature to the Notice List.
Added feature to support incremental patch updates.
2.21 Updated versioning to support the updated backend.
3.0 Removed Change Devices dialog.
310 Locked down number entry to the English format (decimal place is always a period).
Added a log file that can be accessed from the About box. Debug messages are redirected to it.
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Revision history

Infineon

Revision Date Description

** 11/27/2018 New document.

*A 02/26/2019 Updated to version 1.1.

B 10/16/2019 Updated to version 1.2.

*C 11/19/2019 Added GitHub link to the document.
*D 03/27/2020 Updated to version 2.1.

*E 09/01/2020 Updated to version 2.20.

*F 12/20/2020 Updated to version 2.21.

*G 03/15/2021 Updated to version 3.0.

*H 09/08/2021 Updated to version 3.10.
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